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Short Octave Program to Map Lunar Spectral Features: Application to Lunar
Geologic Studies

by Richard Evans and Raffaello Lena

Geologic Lunar Research (GLR) group

Abstract

This paper describes a short Octave program to map lunar spectral features from input
Clementine or Selene VIS+NIR imagery. The program creates absorption trough band
center and band depth maps and also a FWHM map of the absorption trough.

Introduction

Iron containing lunar rocks/minerals can often be identified by analysis of the
characteristics of the iron absorption trough present in lunar reflectance spectra at about
1.0 micron wavelength. These spectra are obtained by remote sensing of lunar terrain.
The absorption trough band center, band depth, and the FWHM (full height at half
maximum) are useful in rock/mineral characterization. Generally these parameters are
determined by looking a wavelength vs reflectance plot of a small pixel block selected
from a set of calibrated lunar images taken from roughly 0.75 microns to 1.5 microns for
Clementine imagery and 0.749 microns to 1.548 microns for Selene imagery. Low
calcium pyroxenes have band centers between about 0.89 microns and 0.95 microns.
High calcium pyroxenes have band centers between about 0.95 microns and 1.0 microns.
Olivine typically has a band center above 1 micron. The deeper the absorption trough
then the more mafic a lunar terrain is likely to be. The wider the FWHM for a given
terrain, the more likely it is that the terrain contains either olivine or impact melt
material.

Although block spectral plots are very informative, it is also useful to get a wider
perspective by looking at maps of band center, band depth and FWHM for a given lunar
terrain under study. This map creation was achieved using the free GNU program
Octave and created maps were visualized using the free spreadsheet program Open
Office Calc and the free image viewer ImageJ version 1.43j.
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Methodology

Algorithms were written in Octave to import calibrated Clementine (0.75 thru 1.5
microns) or Selene band images (0.749 thru 1.548 microns) and export band center, band
depth and FWHM maps of the image sets. The programming code for these algorithms
(ClementineMaps.m and SeleneMaps.m ) is available respectively in Appendix 1 and
Appendix 2. Both the Clementine and Selene algorithms use function calls to two non-
commercial publicly available algorithms: akima.m and fwhm.m Akima.m is a spline
interpolation subroutine while fwhm.m calculates the FWHM of input data. Akima.m
was written by Nagaraja Shamsundar, Assoc. Professor (Retd.)
University of Houston and fwhm. m was written by Petr Mikulic (Assoc. Professor,
Dept. of Condensed Matter Physics, Masaryk University, Czechoslovakia). The akima.m
function file is available from: www.mathworks.com/matlabcentral/fileexchange/1814
which should make any future updates available, but it is listed in Appendix 3 . The code
for the fwhm.m function file is given in Appendix 4 and the latest version is available at:
http://octave.svn.sourceforge.net/viewvc/octave/trunk/octave-forge/main/signal/inst/
fwhm.m?view=markup&pathrev=6041

We downloaded the file using Microsoft WordPad and saved it with a .m extension, but
in text format, which could be opened in Microsoft Notepad. Be careful that long
comment lines preceded by % don’t exceed the right margin in Notepad and continue on
the next line down, because to avoid strange error messages you might have to add a %
symbol to the beginning of this line of continued comment. Newer program versions are
more flexible and contain more possibilities for the Octave programmer to explore, but at
the expense of being longer and having a significantly longer computing time associated
with them. We find that earlier versions such as version July 15, 2009 whose code is
included in Appendix 4 are perfectly adequate for the purpose described here, and run
much faster.

The produced maps have a spectral resolution of 1 nm. Program run time is about 30
minutes to 45 minutes for an input size of about 150 x 150 pixels for each band image.
Map images are output in a text format that includes a header. This header must be
removed before viewing the maps in ImageJ. This is easily done by importing the maps
into Open Office Calc, removing the header information, and saving the maps in csv (i.e.
comma separate value) text format. ImageJ versions of 1.43J and higher will import the
csv text files of the maps as text images.

A set of instructions for producing spectral maps on Windows platforms is given in

GEOLOGIC LUNAR RESEARCH SELENOLOGY TODAY 18
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Appendix 5. Links for downloading Octave, Open Office Calc, and ImageJ are also
provided there as are links to Clementine and Selene image archives.

The instructions and programming code and any other materials present in this paper
or provided by Selenology Today are for use solely at the users risk and come with no
guarantee that they will work on your system. The risk of using this material lies
entirely with the user. The material has so far been tested only on a Windows XP
operating system and possible problems or adverse effects on other systems have not
been evaluated.

Results

Maps produced for several lunar features using calibrated Selene imagery and
Clementine USGS calibrated imagery are shown below.

GEOLOGIC LUNAR RESEARCH SELENOLOGY TODAY 18
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Figure 1. Input: Selene calibrated imagery of Bullialdus central peak area
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Figure 2. Input: Clementine USGS calibrated band images of Archimedes
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Figure 3. Dionysius Crater, Selene Apollo 16 and lunar sample #62231 calibration
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Figure 4. Mons Hansteen, Clementine VIS + NIR, standard USGS calibration
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Figure 5. Mersenius S, Clementine VIS + NIR, standard USGS calibration
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Conclusions

A complete discussion of the interpretation of these maps is beyond the scope of this
paper, but the principles involved have been thoroughly discussed in our preceding
articles (Evans, 2007; Evans et al., 2009a; Evans et al., 2009 b). Only a brief discussion
can be given here. The most common minerals containing iron on the moon are
pyroxenes and olivine. These have absorption troughs in the vicinity of 1000 nm and the
specific trough band center, depth, and FWHM width are helpful in distinguishing them.

An illustration of the spectral parameters and differences, which denote the chemical
differences between specific minerals is shown in Table 1.

In general, low calcium content pyroxenes are called orthopyroxenes and the most
common encountered on the lunar surface are rocks containing some amount of norite.
The central peaks of Bullialdus crater are a good example of a location in which norite
can be found. The greater the amount of iron present, the greater the band depth and the
more mafic the terrain is. Amounts of iron under about 5% are not very mafic and are
typically anorthositic. Such terrain constitutes the majority of the lunar highlands. More
mafic areas with greater iron concentrations are present in some areas, however, such as
the central peaks of Bullialdus described above. The peaks are largely noritic, but with
some mixed composition present in some areas. Noritic features usually have band
centers under 0.95 microns and band depths significantly greater than 5%. FWHM band
width is usually significantly less than 0.3 microns.

In contrast, high calcium content pyroxenes are called clinopyroxenes. Small amounts of
clinopyroxenes, typically less than 5%, are found in the rather anorthositic soils of the
lunar highlands. More mafic clinopyrene content is found in mare basalts and in the
central peaks and walls of some craters such as Tycho. Clinopyroxenes gave band
centers between 0.95 microns and 1.0 microns.

Their FWHM widths are similar to those of orthopyroxenes. Olivine has a band center
above 1.0 microns and the most well known olivine rich area is the central peak region of
the crater Copernicus. Some lunar mare also contain significant amounts of olivine.
Pure olivine is called dunite and lesser amounts are referred to as troctolite.
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Table 1

Rock Type Mineral
Absorption

Band
Remarks

Basalt High-Ca pyroxene (>50%)
0.95 - 1.00 mi-

crons

Basalt with high
olivine

High-Ca pyroxene, olivine

(10-20%)
0.95 - 1.00 mi-

crons

Olivine broadens absorp-
tion band, moves to
slightly higher wave-
lengths

Anorthosite
Plagioclase feldspar, little or

no pyroxene (<5%)
No pyroxene ab-

sorption band

Norite
Plagioclase feldspar, low-Ca

pyroxene
0.90 - 0.93 mi-

crons

Band strength varies with
pyroxene content. Pyrox-
ene has higher Ca content,
or rock contains compo-
nent of high-Ca mixed in
similar to basalts but have
lower abundance of pyrox-
ene.

Norite Plagioclase feldspar, low-Ca
pyroxene

0.93 - 0.95 mi-
crons

Gabbro High-Ca pyroxene
0.97 - 1.00 mi-

crons

Similar to Basalts, but have
lower abundance of pyrox-
ene

Gabbro
High-Ca pyroxene with low-

Ca pyroxene
0.95 - 0.97 mi-

crons

Dunite Olivine 1.1 microns

Troctolite Feldspar with olivine 1.1 microns
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The FWHM width of olivine is wider than that of orthopyroxene or clinopyroxene and is
usually greater than 0.3 microns. Lunar features that lack iron content and so show no
absorption trough near 1.0 micron and lack other minerals such as ilmenite, are likely to
be more purely anorthositic. The central peaks of the crater Aristarchus are a good
example.

The present Octave algorithms allow interested amateur astronomers to develop spectral
maps of lunar features in a quick and simple manner. It is hoped that this will assist in
making lunar spectra generally more accessible to the amateur astronomy community.
The present algorithms for Clementine and Selene band images are simple tools, but
sufficient to produce very useful spectral maps. It is hoped that over time interested
individuals may further improve upon this work and make their algorithms and results
available. Moreover we are doing an extension of our analysis including elemental
abundances maps. Such analyses will provide insight into the global and regional internal
geologic processes responsible for the formation of the various types of lunar features.

Today, amateur astronomers having a modest background in mathematics and the
physical sciences and equipment amounting to little more than a computer and internet
connection can make useful contributions to our understanding of lunar geology using
readily available spectral data and public domain software.

A future target will include an extension of all our analysis, including the release of a
manual for lunar spectral work.
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Appendix 1: Algorithm for Selene Imagery

% Algorithm to Extract bcw, depth and fwhm from Selene band images 749 – 1548 nm

% load Selene 749nm thru 1548 nm images into matrices A1 through A7

cd c:\Octave\Bullialdus

A1 = dlmread ("749.txt")

A2 = dlmread ("901.txt")

A3 = dlmread ("950.txt")

A4 = dlmread ("1000.txt")

A5 = dlmread ("1049.txt")

A6 = dlmread ("1248.txt")

A7 = dlmread ("1548.txt")

% Create a 7 dimensional matrix D whose sheets are A1 through A7

D( :, :, 1) = A1

D(:, :, 2) = A2

D(:, :, 3) = A3

D(:, :, 4) = A4

D(:, :, 5) = A5

D(:, :, 6) = A6

D(:, :, 7) = A7

% Create a 7 dimensional matrix E whose sheets are all A1

E(:, :, 1) = A1

E(:, :, 2) = A1

E(:, :, 3) = A1
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E(:, :, 4) = A1

E(:, :, 5) = A1

E(:, :, 6) = A1

E(:, :, 7) = A1

[nr,nc] = size(A1)

% Normalize all Selene image bands to 750 nm band image

N = D./E

%Start of Main Algorithm

r = 0

c = 1

%***************************************************************

for d = 1:nr*nc

r = r + 1

if r == nr + 1

r = 1

c = c + 1

endif

if c == nc + 1

c = 1

endif

% Calculate Continuum line for first pixel

slope = (N(r,c,7) - 1)/0.799

intercept = -1 * ((slope * .749) -1)

ARCH

SELENOLOGY TODAY 18
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% Continuum divided spectra

x1 = 0.749*slope + intercept

x2 = 0.901*slope + intercept

x3 = 0.950*slope + intercept

x4 = 1.0*slope + intercept

x5 = 1.049*slope + intercept

x6 = 1.248*slope + intercept

x7 = 1.548*slope + intercept

M(r,c,1) = N(r,c,1)/x1

M(r,c,2) = N(r,c,2)/x2

M(r,c,3) = N(r,c,3)/x3

M(r,c,4) = N(r,c,4)/x4

M(r,c,5) = N(r,c,5)/x5

M(r,c,6) = N(r,c,6)/x6

M(r,c,7) = N(r,c,7)/x7

% apply cubic spline for continuum divided spectral data

H = [.749 .901 .950 1.0 1.049 1.248 1.548]

I = [M(r,c,1) M(r,c,2) M(r,c,3) M(r,c,4) M(r,c,5) M(r,c,6) M(r,c,7)]

% interpolate spline using Akima Interpolation at approx. 1 nm intervals

xi = [linspace(0.749, 1.548,800)]

ysi = akima(H,I,xi)
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% remove the % sign in the line below to enable the plot function

% plot(H,I,'o',xi,ysi,':')

% get bcw

[ymin,i] = min(ysi)

bcw = xi(i)

% get depth

depth = 1 - ysi(i)

% get FWHM uses Petr Mikulik m file for FWHM calculation

z = ones(1,800)

aa = z.- ysi'

x = xi(1:800)

y = aa(1:800)

width = fwhm(x,y)

% build up data matrices

BCW(r,c) = bcw

DEPTH(r,c) = depth

FWHM(r,c) = width

bcw

depth

width
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endfor

%**********************************************************************

% save map images

save ("-text","bandcenter","BCW")

save ("-text","banddepth","DEPTH")

save("-text","fwhm","FWHM")

Appendix 2: Algorithm for Clementine Imagery

% Algorithm to Extract bcw, depth and fwhm from Clementine 750 nm thru 1500 nm
imagery

% load Clementine txt images from c:\Octave\ClemArchimedes 750nm to 1500 nm and
assign to A1 thru A7

cd c:\Octave\ClemArchimedes

A1 = dlmread ("750.txt")

A2 = dlmread ("900.txt")

A3 = dlmread ("950.txt")

A4 = dlmread ("1000.txt")

A5 = dlmread ("1100.txt")

A6 = dlmread ("1250.txt")

A7 = dlmread ("1500.txt")
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% Create a 7 dimensional matrix D whose sheets are A1 through A7

D( :, :, 1) = A1

D(:, :, 2) = A2

D(:, :, 3) = A3

D(:, :, 4) = A4

D(:, :, 5) = A5

D(:, :, 6) = A6

D(:, :, 7) = A7

% Create a 7 dimensional matrix E whose sheets are all A1

E(:, :, 1) = A1

E(:, :, 2) = A1

E(:, :, 3) = A1

E(:, :, 4) = A1

E(:, :, 5) = A1

E(:, :, 6) = A1

E(:, :, 7) = A1

[nr,nc] = size(A1)

% Normalize all Selene image bands to 750 nm band image

N = D./E

%Start of Main Algorithm

r = 0
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c = 1

% ********************************************************************

for d = 1:nr*nc

r = r + 1

if r == nr + 1

r = 1

c = c + 1

endif

if c == nc + 1

c = 1

endif

% Calculate Continuum line for first pixel

slope = (N(r,c,7) - 1)/0.750

intercept = -1 * ((slope * .750) -1)

% Continuum divided spectra

x1 = 0.750*slope + intercept

x2 = 0.900*slope + intercept

x3 = 0.950*slope + intercept

x4 = 1.0*slope + intercept

x5 = 1.1*slope + intercept

x6 = 1.25*slope + intercept

x7 = 1.5*slope + intercept

M(r,c,1) = N(r,c,1)/x1
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M(r,c,2) = N(r,c,2)/x2

M(r,c,3) = N(r,c,3)/x3

M(r,c,4) = N(r,c,4)/x4

M(r,c,5) = N(r,c,5)/x5

M(r,c,6) = N(r,c,6)/x6

M(r,c,7) = N(r,c,7)/x7

% apply cubic spline for continuum divided spectral data

H = [.750 .90 .950 1.0 1.1 1.25 1.5]

I = [M(r,c,1) M(r,c,2) M(r,c,3) M(r,c,4) M(r,c,5) M(r,c,6) M(r,c,7)]

% interpolate spline using Akima Interpolation at approx. 1 nm intervals

xi = [linspace(0.75, 1.5,750)]

ysi = akima(H,I,xi)

% remove the % sign in the line below to enable the plot function

% plot(H,I,'o',xi,ysi,':')

% get bcw

[ymin,i] = min(ysi)

bcw = xi(i)

% get depth

depth = 1 - ysi(i)

% get FWHM uses Petr Mikulik m file for FWHM calculation

z = ones(1,750)

aa = z.- ysi'

x = xi(1:750)
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y = aa(1:750)

width = fwhm(x,y)

% build up data matrices

BCW(r,c) = bcw

DEPTH(r,c) = depth

FWHM(r,c) = width

bcw

depth

width

endfor

%**********************************************************************

% save map images

save ("-text","bandcenter","BCW")

save ("-text","banddepth","DEPTH")

save("-text","fwhm","FWHM")
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Appendix 3: Akima.m

function yi=akima(x,y,xi)

%

% Usage: yi=akima(x,y,xi)

%

% Given vectors x and y (of the same length)

% and the array xi at which to interpolate,

% fits piecewise cubic polynomials and returns

% the interpolated values yi at xi.

%

% Ref. : Hiroshi Akima, Journal of the ACM, Vol. 17, No. 4, October 1970,

% pages 589-602.

%

% Programmer: N. Shamsundar, University of Houston, 6/2002

% Correction to lines 32-33, 9/2004, motivated by Gilford Ward,

% to make routine work correctly for linear data.

%

% Notes: Use only for precise data, as the fitted curve passes through the

% given points exactly. This routine is useful for plotting a pleasingly

% smooth curve through a few given points for purposes of plotting.

%

x=x(:); y=y(:); xi=xi(:); n=length(x);

if n~=length(y), error('input x and y arrays must be of same length'), end
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dx=diff(x); if any(dx <= 0) error('input x-array must be in strictly ascending order'), end

if any(xi<x(1)) | any(xi > x(n))

warning('All interpolation points xi must lie between x(1) and x(n)')

end

m=diff(y)./dx;

mm=2*m(1)-m(2); mmm=2*mm-m(1); % augment at left

mp=2*m(n-1)-m(n-2); mpp=2*mp-m(n-1); % augment at right

m1=[mmm; mm; m; mp; mpp]; % slopes

dm=abs(diff(m1)); f1=dm(3:n+2); f2=dm(1:n); f12=f1+f2;

id=find(f12 > 1e-8*max(f12)); b=m1(2:n+1);

b(id)=(f1(id).*m1(id+1)+f2(id).*m1(id+2))./f12(id);

c=(3*m-2*b(1:n-1)-b(2:n))./dx;

d=(b(1:n-1)+b(2:n)-2*m)./dx.^2;

% Loop replaced by vector ops following tip from johannes.korsawe@volkswagen.de

% 1/19/2006

%

[ncnt,bin]=histc(xi,x);

bin=min(bin,n-1);

bb=bin(1:length(xi));

wj=xi-x(bb);

yi=((wj.*d(bb) +c(bb)).*wj+b(bb)).*wj+y(bb);
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Appendix 4: fwhm.m

%% Compute full-width at half maximum (FWHM) for vector or matrix data y,

%% optionally sampled as y(x). If y is a matrix, return fwhm for each column

%% as a row vector.

%% f = fwhm(y)

%% f = fwhm(x, y)

%% f = fwhm(x, y, 'zero')

%% f = fwhm(x, y, 'min')

%%

%% The default option 'zero' computes fwhm at half maximum, i.e. 0.5*max(y).

%% The option 'min' computes fwhm at the middle curve, i.e. 0.5*(min(y)+max(y)).

%%

%% Return 0 if FWHM does not exist (e.g. monotonous function or the function

%% does not cut horizontal line at 0.5*max(y) or 0.5(max(y)+min(y)),

%% respectively).

%%

%% Compatibility: Octave 3.x, Matlab

%% Author: Petr Mikulik

%% Version: 15. 7. 2009

%% This program is public domain.

function myfwhm = fwhm (x, y, opt)
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if nargin < 1 || nargin > 3

error('1, 2 or 3 input arguments required');

end

if nargin==1

y = x;

x = 1:length(y);

opt = 'zero';

elseif nargin==2

opt = 'zero';

end
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Appendix 5: Instructions for Algorithm Use for Windows only

Important Disclaimer: The instructions and programming code and any other
materials present in this paper or provided by Selenology Today are for use solely
at the users risk and come with no guarantee that they will work on your system.
The risk of using this material lies entirely with the user. The material has so far
been tested only on a Windows XP operating system and possible problems or
adverse effects on other systems have not been evaluated.

1. Download and install Octave from here:

http://octave.sourceforge.net/

2. Download and install Open Office from here:

http://download.openoffice.org/

3. Download and install ImageJ from here:

http://rsb.info.nih.gov/ij/download.html

When installed, immediate upgrade the program by running it and selecting

Help > Update ImageJ

any version 1.43j or higher should work fine; versions prior to 1.43i will not work for
this application

4. Download a set of 16 bit tiff spectra from 750 to 1500 nm for Clementine or 749
nm to 1548 nm for Selene (but the Selene spectra have to be calibrated before they
can be used).

For Selene: https://www.soac.selene.isas.jaxa.jp/archive/index.html.en

For Clementine: www.mapaplanet.org/explorer/moon.html

Since Clementine data are already calibrated and individual image tiles have already
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been made into mosaics, it is a great deal easier to work with this data set. During
image download set stretch to none for Clementine images.

Convert these 16 bit tiff images to txt images using ImageJ (version 1.43j or higher)
and then put the txt spectral band images in a subdirectory with the name of the lunar
feature they represent as a subdirectory of C:\octave for example for Bullialdus the
subdirectory to be created would be:

c:\octave\bullialdus

5. Copy each of the algorithms in Appendix 1 through 4 to a text editor

and save them with the names SeleneMaps.m ClementineMaps.m Akima.m and
fwhm.m The files should not be given a txt extension, but rather a .m extension.

6. Put these .m files also into the subdirectory (you need only the SeleneMaps.m or
the Clementine.m depending on your data set, but not both)

7. In the Windows accessory program notepad or your text editor, open the file
ClementineMaps.m and note that you must make a change to the 3rd line of the
program for lunar feature data sets of lunar features other than that provided in this
example.

cd c:\Octave\ClemArchimedes

the change is just to replace ClemArchimedes with the name of the subdirectory you
created above. So if you have downloaded band images for Pytheas crater then the
subdirectory is Pytheas, for example, and so change line 3 of the program
to: c:\Octave\Pytheas

Now, just save the program. Be very careful not to save it with a .txt extension since
the file extension must be .m even though it is basically just a txt file that can be read
and changed in notepad.

8. Now open Octave and change directories to the subdirectory you created above. If
the subdirectory is named Pytheas, then the procedure is to enter at the command
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prompt:

cd c:\Octave\Pytheas

9. Now just type in the name of the program for Clementine images which is:

ClementineMaps

You must not type in ClementineMaps.m but only ClementineMaps

10. The bandcenter, banddepth, and fwhm maps will now be created automatically
and this will take about 30 minutes to one hour depending on the speed of your
computer.

11. While it is running, you can minimize the program and do other things on the
computer if you want.

12. When the computer finishes the program, then type quit and this will exit the
program.

13. Now open Open Office Calc, the spreadsheet program you downloaded and
installed.

14. Under the top menu choose Insert > Sheet from file

For each of the files that now have appeared in your octave subdirectory that you
created above (bandcenter, banddepth, fwhm) then load the file into Open Office Calc
choosing delimited, tab, and space as options.
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15. When this is accomplished delete the first column (column A) from the resulting
data spreadsheet and delete the header lines. This will leave the txt image data. If
you wish you can increase the decimal precision of the data by choosing the format
cells option for all cells in the spreadsheet and increase it from 2 to 3 decimal places,
but this is optional and do it only if you wish. Now, Save the file as a Text csv file.

16. Open the Text csv file in ImageJ as a text image. You will see the map image
which should appear beautifully.

17. After doing the bandcenter file, proceed then to the banddepth and then to the
fwhm files created in Octave that are present in the subdirectory that you created.

This procedure will allow you to make maps quickly any time you choose and should
be a help in lunar spectral work. The maps have a spectral resolution of 1 nm. They
will calculate in between 30 minutes and 1 hour depending on your computer for files
of roughly a dimension of 166 x 142 pixels. Larger images will take proportionally
longer to produce. When the program finishes, no data will be directly displayed
however the 3 map files will automatically appear in the subdirectory you created
above.
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Using Selene 2B2 level calibrated Multispectral Imager (MI) band
images to generate reflectance spectra and spectral maps of lunar
features

By Richard Evans Geologic Lunar Research (GLR) group

Abstract

The purpose of this paper is to demonstrate how to download and process Selene
Multispectral Imager (MI) band images so that they can be used to produce spectra and
spectral maps of lunar features. A single tile of Copernicus Peak 3 is used for
demonstration purposes using a calibration based on Mauna Kea 2.2 meter telescope
120 color spectra.

Introduction:

Calibration of Selene Multispectral Imager (MI) band images has currently reached level
2B2. This level of calibration basically includes radiometric calibration and conversion
of output to radiance. In the future, 2C calibration will eventually become availalbe and
will include photometric calibration with conversion of output to reflectance and also a
systematic geocorrection of image bands. However, even at the present stage of
calibration, it is possible to use Selene data in a limited way to generate spectra of lunar
features and to generate spectral maps. The purpose of Part I of this paper is to explain
how to acquire Selene multispectral imager VIS and NIR band data and to further
enhance its calibration for the purpose of generating relative reflectance spectra and
producing maps of spectral features.

Part I: Selecting, Downloading, Converting and Saving Selene Archive IM Images

The Selene Multispectral Imager Dataset: General Description

The Selene (Kaguya) lunar probe acquired multispectral images at VIS and NIR
wavelengths between September 2007 and June 2009. Five VIS bands were obtained at
0.415, 0.75. 0.9, 0.95, and 1.0 microns. Four NIR bands were obtained at 1.0, 1.05, 1.25,
and 1.55 microns. The resolution of VIS bands is 20 meters/pixel. The resolution of NIR
bands is 62 meters/pixel. These images have not yet been assembled into a fully
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calibrated mosaic as is the case for Clementine data, but they are available for download
from the Selene Data Archive as single tile data. VIS five band images are packaged
together in 16 bit unsigned data with Little Endian byte order with a variable length data
header preceeding the first image. There are no bytes between images and the images are
co-aligned. NIR four band images are packaged together in the same way. VIS and
NIR images may or may not be offset from each other and it may well be necessary for
the user to co-align VIS images with NIR images. VIS images are typically about 962 x
959 pixels although there is variation here. NIR images are typically about 320 x 319
pixels. Once the VIS images are re-scaled to the dimensions of NIR images, subpixel co-
alignment (i.e. co-registration) may require more than applying a simple (x,y) pixel
offset.

Finding a Lunar Feature in the Selene Archive and Downloading VIS and NIR
data:

The first step here is to create an individual free account on the Selene Data Archive
website at: https://www.soac.selene.isas.jaxa.jp/archive/ which will enable access to
the various Selene data products. Once logged into the data search system, it is
necessary to specify the desired product. For the currently available Multispectral
Imager data the product name is LISM 2B2. Pressing the “Determination” icon selects
the listed product. Next, the time and date of the desired data is entered, but in practice it
is enough to simply list the start date of September 14, 2007. The desired lunar feature is
selected using the Observation Range menu, by simply pressing the Setup Observation
Range icon. This will lead to the generation of a lunar map. The user simply draws a box
around the target area of interest and zooms the image. A fairly high zoom level is
usually desirable. Individual Selene VIS and NIR data tiles are not much larger than the
area covered by Copernicus Peak 3. The icon labelled “Determination of Selection
Range” is pressed to send the longitude and latitude coordinates of the area of interest to
the main search page. All necessary constraints have now been chosen and the “Search
Execution” icon can be pressed to access the available band data.

Available data tiles will be listed but it will be necessary to select VIS or NIR image
groups separately. Thumbnails of the feature can be viewed to aid in the selection of VIS
and NIR image packages. Care should be taken to choose VIS and NIR image packages
that show exactly or at least nearly the same geography (some offset may be present
between the image groups). Desired packages are added to an order list which is then
confirmed by the user. NIR and VIS files are chosen separately. The Selene archive will
send a confirmation of the order and in a second email will specify a download address.
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Working with Downloaded Selene Archive VIS and NIR Data Packages:

Downloaded VIS and NIR packages will be in .sl2 format. Windows users should
convert the file extension to a .tar extension. This will allow unzipping each package
using common programs such as WinZip. Several files are present within each package,
but the important file is actually a zipped file with the extension .igz. It is necessary to
change this extension to a .gz extension which then allows it to be opened with WinZip,
gzip etc. When this file is unzipped, the most important resulting file has an .img
extension. This file contains the archived image bands and a preceeding header with lots
of image data. The file is in an unusual .pds type image format which most programs
cannot read. I generally make a copy of the .img file and give it the extension .pds for
reasons that are explained below.

Using ImageJ to Open the .img file:

ImageJ is one of my favorite free image processing programs. It is available for
download at: http://rsbweb.nih.gov/ij/download.html but to use it to work with Selene .img
files it is necessary to download an additional free plugin called the Raw File Opener which
is found under the Input/Output section here: http://rsbweb.nih.gov/ij/plugins/index.html

Simple instructions for installing the plugin are present on at the download site: http://
rsbweb.nih.gov/ij/plugins/raw-file-opener.html

When it is installed and working, the Raw File Opener is selected from within the ImageJ
menu: Plugins > Input-Output > Raw File Opener.

Reading Image Header Information:

Using File > Open in ImageJ, the copy of the .img file that was renamed to a .pds extension
can be viewed, but only the header information will be legible. However, reading the header
information will give some key pieces of information needed to unpack the images in the
VIS and NIR .img files. Files will always be in 16 bit unsigned format with Little Endian
byte order and zero bytes between images. VIS .img files will contain five image bands and
NIR .img files will contain four image bands. But header information will give the image
width and height and the number of header bytes present before the first image. These should
all be recorded.
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Opening the .img image package for VIS and NIR:

VIS and NIR .img files are opened in ImageJ using the Raw File Opener plugin: Plugins >
Input-Output > Raw File Opener. Information present in the header information must be
entered and is different for VIS and NIR .img files. Image dimensions can vary slightly for
different geographical areas imaged as well. For the most part, NIR files are about 320 x 319
pixels and VIS files are roughly 962 x 959 pixels.

When an image is opened successfully it will open in an image sequence viewing box with
four bands for NIR and five bands for VIS which can be viewed by moving a slider at the
bottom of the image sequence viewing box in ImageJ. Each image should have the
appearance of the thumbnail image included in .jpg format in each download. If the images
are distorted or skewed then most likely small variations will be needed to adjust the image
dimensions. Sometimes very small adjustments to the dimensions given in the header are
needed.

Each image should be saved as a 32 bit tiff image Image > Type >32 bit and the VIS images
should be re-scaled to the dimensions of the NIR images. When this is done, the VIS+NIR
images can be opened as a single image sequence in ImageJ (see below). The nine VIS+NIR
image bands should be saved to their own directory. The name of each tif image should be
changed to its band wavelength keeping the tif extension. Use 1000.tif for the VIS 1000 nm
band and 1000a.tif for the NIR 1000 nm band image. When Import > Image Sequence is
selected in ImageJ, clicking on the first band image will allow the entire group to be
imported.

Saving the VIS and NIR images in 32 bit tif format:

When the VIS and NIR images are opened, they are best changed to 32 bit tiff type if this
was not done previously. This is achieved as follows: Image > Type >32 bit and their image
groups are saved as separate image sequences as follows: File > Save As > ImageSequence
> tif. Each individual image within the VIS and NIR groups are thereby saved as individual
tif images in 32 bit format. If necessary, the brightness and contrast of the images can be
altered without changing the pixel values as follows: Image > Adjust > Brightness and
Contrast. The images should be re-named according to their band wavelength and saved in
32 bit tiff format. It is convenient to name the 1000 nm VIS image as 1000.tif and the 1000
nm NIR image as 1000a.tif.
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Co-Alignment of VIS+NIR band images:

If when viewing the image sequence of all VIS+NIR band images, it is obvious that the two
groups of images are offset from each other, then it will be necessary to co-align them to
subpixel accuracy. This must be done using software capable of working with 32 bit images.
I generally open the NIR and VIS bands as two separate image groups in ImageJ and place
them side by side. I crop each set to make them as identical topographically as possible and
resize the VIS image sequence to the same dimensions as the NIR image sequence. Any
ragged edge artifacts need to be cropped out. After this is done, the VIS+NIR image stack is
then image stabilized using the image stabilizer plugin for ImageJ. If alignment still isn’t
good (which is rare), I sometimes use the commercial program MiraPro 7 to do a multipoint
alignment and then repeat the image stabilization. Instructions for the co-alignment process
using this software package are beyond the scope of this paper, but are included int he
manual for MiraPro 7.

Part II: Generating Spectra and Spectral Maps using Selene IM images

Image Re-Calibration:

Method 1: Using Apollo 16 site and Apollo 16 Soil Sample 62231

The VIS + NIR band images as a 9 image group are loaded into ImageJ as an
ImageSequence. This is facilitated by putting only these 9 images into their own
directory and when opening the Image Sequence, only the first tif file is selected, all of
the images will automatically be opened in the image sequence in order of increasing
band wavelength. There are two different approaches to image calibration each with its
good and bad points. One method is to select the Apollo 16 landing site as the first set of
VIS and NIR images downloaded from the Selene Archive.

The VIS + NIR band images as a 9 image group are loaded into ImageJ as an
ImageSequence. This is facilitated by putting only these 9 images into their own
directory and when opening the Image Sequence, only the first tif file is selected, all of
the images will automatically be opened in the image sequence in order of increasing
band wavelength.
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Step 1: Image Normalization for Apollo 16 Site Band Images

With the Image Sequence opened, an area of medium albedo within the Apollo 16 site is
selected using the “box” icon on the ImageJ menu. It should be on the order of 1000 or
so pixels in size. As the slider is moved at the bottom of the viewer, the next band image
will appear, but the boxed area remains in the same position. Pressing Control-H will
bring up the histogram data window and the average pixel DN value can be read. It
should be recorded for each of the nine band images. The box is then removed by
clicking anywhere on the selected image.

Each band image is mathematically divided by the recorded histogram average pixel DN
value recorded for the boxed area as described above. This is done in ImageJ by:

Process > Math > Divide. When the division is made ImageJ asks if the division is to be
applied to the currently selected image or to all images. It should be applied only to the
currently selected image. The next image is then selected and divided by its boxed
histogram value, and the next, and so on until all nine images have been “normalized”.

If after the normalization process is completed, all of the band images do not have quite
nearly the same DN value for a selected large pixel block area, then most likely the
Apollo 16 site is not a good calibration site for the data set under study. When this is the
case, it is usually the 0.415 or the 0.749 micron bands that will appear brighter than the
other bands after normalizaion, indicating a bad calibration result is likely to occur.
When this happens, I usually abandon Method 1 and try to move on to Method 2.
However, if the the problem is only with the 0.415 micron band then this band is not
essential to determination of the trough parameters close to 1 micron and Method 1 can
still be used for this work. It is essential,however, that the 0.749 micron band be well
normalized.

Step 2: Image Re-Calibration for Apollo 16 Band Site Images

The file RELABBDR.TAB is downloaded from the PDS Geosciences Node found here:

http://pds-geosciences.wustl.edu/missions/lunarspec/
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This file is opened in Excel or a similar spreadsheet program. The file contains
calibration correction gain coefficients based on Apollo 16 soil sample #62231 convertd
to bidirectional reflectance (bidirectional reflectance is used to correct lunar probe data
while hemispheric reflectance is used to correct Earth based telescope data).

The calibration factor for each Selene VIS and NIR band should be recorded from the
relabbdr.tab file. Interpolation is necessary for many of the bands. Using ImageJ, each
previously normalized Apollo 16 Selene band image is multiplied by its corresponding
correction factor. The image sequence is then saved as a series of 32 bit tif images. Feel
free to adjust the brightness and contrast of 32 bit tiff images as this does not affect their
pixel values.

The Selene VIS and NIR band images of the Apollo 16 site has now been completed and
can be used for calibration of Selene data for other lunar features. The calibrated Apollo
16 site images should be viewed as an image sequence in Image J and the average DN
balue of the Apollo 16 site determined for each band image using the histogram function.
The values should be recorded for each band.

Step 3: Calibration of other lunar features against the Selene Apollo 16 site.

Normalization:

A second set of Selene images is downloaded for the lunar feature of interest. The target
images are normalized by dividing each band image by the histogram value of the un-
normalized and uncalibrated (except for the 2B2 pre-calibration already present in
downloaded Selene imaging spectrometer images) Apollo 16 site image of the same band
wavelength. This is done in ImageJ as described above.

Calibration:

The normalized VIS+NIR band images of the lunar feature of interest are then calibrated
by multiplying each band image by its corresponding correction coefficient found in the
relabbdr.tab file previously discussed.

This completes the calibration of the VIS+NIR band images of the target feature of
interest against the Apollo 16 site and Apollo 16 soil sample 62231.
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Because the Selene 2B2 calibration does not involve geocorrection, however, it is
possible that re-calibrated images using this method might have some residual error.
Therefore Method 2 outlined below is provided for comparison purposes. Method 2 is
based on Mauna Kea 2.2 meter telescope 120 color spectra calibration and has the
advantage of more nearly eliminating the distance between the calibration site and the
target site under investigation. Calibration data obtained with the Mauna Kea 2.2 meter
telescope and McCord circular variable filter (CVF) NIR Photometer is available from
the PDS Geosciences Node as described below.

The results of this calibration are shown in the two figures below. Block spectra were
measured using ImageJ v 1.43J and spectral maps were made in Octave.

Figure 1a: Block Spectra, Coperncius Peak 3, Apollo 16 and soil #62231 calibration
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Figure 1b: Spectral Maps, Copernicus Peak 3, Apollo 16 and soil #62231
calibration

Method 2: Using Mauna Kea 2.2 meter telescope 120 color spectra for calibration

Mauna Kea 2.2 meter telescope 120 color spectra are availabe for a large number of
lunar featrures and have been pre-calibrated to the Apollo 16 soil sample 62231. Since
they are in hemispheric reflectance, each band must be multiplied by a bidirectional
reflectance correction coefficient. Both the Mauna Kea 2.2 meter telescope 120 color
spectra and the bidirectional reflectance correction file can be downloaded from: http://
pds-geosciences.wustl.edu/missions/lunarspec/
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The name of the bidirectional reflectance correction file is: CORRBDR.TAB

By referring to the index which is included in the Mauna Kea 2.2 meter 120 color spectra
download, one of the Mauna Kea 2.2 meter telescope spectral data files closest to the
target feature of interest is chosen and reflectance values are multiplied by the
bidirectional reflectance constant for each of the Selene VIS+NIRwavelengths of the
target feature VIS and NIR datasets that were downloaded from the Selene Archive.

The target feature VIS+NIR spectra are normalized by selecting the same boxed pixel
area for each of the band images and obtaining an average DN value for the boxed area
using the histogram function in ImageJ as was described above. The boxed area should
be near, but not identical to the longitude and latitude of the Mauna Kea 2.2 meter
telescope calibration file to be used. Each VIS+NIR band is then divided by its
histogram box average DN value. This serves to normalize the nine image bands. This is
done as previously described, using the math function in ImageJ within an imported
image sequence of the nine spectral band images in 32 bit tiff format.

Figure 2a: Normalization Area for Copernicus Peak 3 is boxed
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Finally, the normalized bands are multiplied by the bidirectional reflectance corrected
Mauna Kea 2.2 meter telescope spectral values for the adjacent calibration site. Mauna
Kea 2.2 meter telescope data begins at about 0.62 microns, so it is not possible to
calibrate the 0.415 micron Selene VIS image band. This is not very important since only
the 0.75 to 1.55 nm bands are useful in evaluating the absorption trough near 1000 nm
which is essential to mineral identification. The disadvantage of Method 2 is that it
sacrifices the 0.415 band calibration but its advantage is that the calibration and target
sites will be much closer to each other than the target site would be to the Apollo 16 site
used in Method 1. Results of the calibration using Method 2 are shown in the block
spectra and spectral map figures below.

Figure 2b: Copernicus Peak 3 target area (181,34) boxed
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Figure 2c: Copernicus Peak 3, Mauna Kea CVF file HC1220 calibration

Figure 2d: Copernicus Peak 3, Mauna Kea CVF HC1220 calibration. Spectral
Maps
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Figure 2e: OMAT map (optical maturity map) Bright: 0.3, Dark: 0.1 Prepared from
Mauna Kea CVF calibration.

Other Calibration Methods:

For geographic areas where the Clementine UVVIS+NIR data do not show the effects of
thermal sensor instability in the NIR, it is possible to use the Clementine imagery to
calibrate Selene imagery of the same general terrain. This is done procedurally much
like the Mauna Kea 2.2 m telescope with CVF example above, except that the Mauna
Kea calibration file would be replaced by calibrated Clementine UVVIS+NIR spectra
normalized to the 0.75 micron image. After normalizing the selene imagery using a
selected pixel block corresponding to the Clementine geography, the calibrated
Clementine spectral data for each band would be used as a multiplier for the
corresponding Selene band. It is, naturally necessary to interpolate some values such as
the 1.049 micron and 1.548 micron values and a simple spline interpolation is useful for
this purpose.
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We achieved a successful calibration of gamma Reiner using this method which was
chosen because the Apollo 16 site did not normalize the Selene 0.749 band well and a
Mauna Kea 2.2 m CVF data file was not available for the general area of gamma Reiner.

Results:

Evaluation of Mineral Content via characteristics of the iron absorption trough near 1
micron have been discussed in detail in prior Selenology Today articles including:

Evans, R. Analysis of Lunar Spectra and Multiband Images (2007) Selenology Today
Vol. 7. pp. 1-46.

which can be downloaded here: http://digilander.libero.it/glrgroup/journal.htm

To summarize, calibrated Selene spectral band DN values obtained using Method 1 or
Method 2 above, for a boxed pixel area centered on the target site of interest are obtained
from 0.75 to 1.55 microns using the described techniques in ImageJ. The DN values of
all bands are divided by the DN value of the 0.75 micron band, which serves to
normalize the spectra. The normalized spectra are plotted on a relative reflectance vs
wavelength plot and a line through (0.75, 1) and (1.55, y) is taken tangent to the spectral
curve, where y is the relative reflectance of the normalized 1.55 micron band for the
target feature. Next the spectral curve is divided by the tangent line. This is achieved for
each wavelength band by dividing the relative normalized reflectance for that band by
[(the band wavelength in microns * slope of the tangent line) + y-intercept of the tangent
line)]. The plot of the resulting curve vs the band wavelength is the continuum divided
spectrum and is extremely useful in evaluating the iron absorption trough near 1 micron.
This plot has the characteristic that the relative reflectance of the 0.75 micron and the
1.55 micron band will be 1.0. The band center of a trough between these wavelengths
and the percent depth of the trough are significant in assessment of mineral content as
explained in the referenced paper in more detail.

Creation and interpretation of Spectral maps using VIS+NIR spectra is explained in:

Evans R, Woehler C, and Lena R: Spectral mapping using Clementine UV-Visible-NIR
Data Sets: Applications to Lunar Geologic Studies. (2009) Selenology Today, Vol. 14
pp. 1-70.
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which can be downloaded here: http://digilander.libero.it/glrgroup/journal.htm

Figure 3: Comparison of Mauna Kea 2.2 meter telescope based and Apollo 16 site
based calibrations
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Interpretation:

Selene VIS+NIR spectra calibrated using Mauna Kea 2.2 meter telescope 120 color
spectra corrected to bidirectional reflectance gave good results when applied to central
peak 3 of Copernicus. The continuum divided spectra of the absorption trough near 1
micron appear to be less noisy than prior results I have obtained using Clementine
UVVIS+NIR spectra with the standard Clementine USGS calibration based on the
Apollo 16 site and Apollo 16 soil sample 62231. Results for peak 3 of Copernicus in this
study are consistent with a significant olivine composition.

Discussion:

This paper demonstrates a method that amateur astronomers interested in lunar geology
can use to obtain spectra and spectral maps of geologic lunar features of interest using
the present 2B2 calibration of Selene multispectral imager band images. Two methods
by which this 2B2 calibrated data set can be re-calibrated for evaluating the key iron
absorption trough near 1 micron are discussed. They each have advantages and
disadvantages. Use of Method 1 based on the Apollo 16 site and Apollo 16 soil sample
62231 has the disadvantage that target areas of interest will likely be geographically from
the calibration site, but calibration of the 0.415 micron band is achieved. Use of Method
2 based on Mauna Kea 2.2 meter telescope 120 color spectral data pre-calibrated to the
Apollo 16 soil sample 62231 has the advantage that its large number of geographic
calibration sites means that a target area of intrest is likely to be relatively close to a
calibration site, at least as compared to a calibration using the Apollo 16 site such as
Method 1. However, Mauna Kea 2.2 meter telescope 120 color spectra data cannot be
used to obtain a calibration of the 0.415 micron band image.

This paper is limited to block spectra and spectral mapping of Copernicus central peak 3
based on either Apollo 16 and soil # 62231 or Mauna Kea 2.2 meter telescope 120 color
spectrum calibration of the Selene 2B2 VIS+NIR band images. Comparison of the block
spectra and maps derived for these two calibration methods are present for comparison
purposes. For the most part the block spectra are quite similar, although some variation
is present for the site with pixel coordinates of approximately (35,139), i.e. the purple
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block spectra curve, which may reflect sampling error for this particular site. A
comparison of the site with pixel coordinates of approximately (200,154) is shown in
Figure 3. Comparison of the spectral maps also shows that they are quite similar.
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A lunar cone near Flamsteed

by Raffaello Lena Geologic Lunar Research (GLR) group

Abstract

This study uses a spectral mapping technique based on Clementine UVVIS-NIR imagery
to assess the composition of a lunar cone near Flamsteed P. The examined cone has an
elongated base diameter determined as 2.28 x 0.74 km. Its height amounts to 95 ±10 m.
It is aligned along a linear rille formed by tensional stress. Lunar cones aligned along a
linear rille are evidence for the presence of near-surface magma and interpreted to be
the result of degassing and minor eruption subsequent to a shallow dike. Elemental
abundance maps for Al, Ca, Fe, Ti, O, and Mg were generated using a matrix regression
based spatial enhancement of Lunar Prospector data. The goal was to evaluate the
composition of the mare soil and the crater Flamsteed.

1.Introduction

On the Moon there are different cone morphologies. These are due to differences in
eruption style, which is determined by magma volume, extrusion rate, eruption energy
and other factors (Wood, 1979). Lunar cones come in many shapes and sizes: circular
(Osiris in Mare Serenitatis), breached cones with a short sinuous rille disappearing into
the mare (Isis in Mare Serenitatis), or cones that are elongated and aligned along a rille.
On the Earth, cinder cones form when small gas-driven eruptions fragment lava,
extruding it in small “cinders” that pile up around a central vent.

The cones result from the accumulation of cinder and ash around a vent, in association
with Strombolian, Hawaiian and Vulcanian eruptions. The presence of lunar pyroclastic
constructs implies that gas may be released from the erupted magma, causing disruption
of the magma and subsequent dispersal of the clasts (Weitz and Head, 1999).

Instead of a volcanic cone, some lunar eruptions formed a broad, thin layer around the
central vent. Such dark sections are called “dark mantling materials” and generally
represent areas of fire fountaining (Wilhelms, 1987). Fire fountaining occurs when a
rising magma begins the process of degassing. This happens as the magma nears the
lunar surface, and as the gasses come out of solution they may explosively erupt,
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fragment the surrounding magma, and throw small magma droplets high above the lunar
surface. Above the surface, these droplets cool as volcanic glass and then fall around the
vent. Smaller deposits occur as dark haloes around semicircular or irregular depressions
(Wilhelms, 1987; Gaddis et al., 2003); examples include the endogenic dark halo craters
on the floor of the crater Alphonsus. Morphometric data about various lunar volcanic
features has been published by Pike and Clow (1981) in an USGS file report. In this
paper Pike and Clow reported the morphometric properties of 18 lunar volcanoes,
including five lunar cones. The measurements of these lunar volcanoes (diameter, height,
depth of the summit crater) were computed from Lunar Topographic Orthophotomosaics,
Lunar Orbiter imagery, and Apollo images. Clementine UVVIS multispectral imagery
were also used to study the spectral signatures of cones like Isis, Osiris, Rima Parry,
Mons Esam and the so-called horseshoe cones in the Marius Hills region (Weitz and
Head, 1999). This study describes a lunar volcanic cone near Flamsteed P formation,
situated at the selenographic coordinates 42.42° W and 4.86° S. The morphometric
characteristics of the lunar cone are examined relying on high-resolution imagery taken
by LRO Wide Angle Camera. Furthermore, this study aims for determining the
elemental, mineralogical, and spectral characteristics of the geologic units around
Flamsteed P using Clementine UVVIS+NIR data.

2. Digital images and measurements

Lunar Orbiter IV-143-H3 (Fig. 1a and 1b) displays a lunar cone located near the crater
Flamsteed P (Fig. 1c). A recent image (WAC M117779352ME) of the feature, publicly
released on the LROC website, was taken with the Wide Angle Camera on 2010-01-10
UT 16:14:44 (Fig.2). The image (http://lroc.sese.asu.edu/news/uploads/LROCiotw/
wac.M117779352ME.bwmos.png) is oriented with north to the top and west to the left.
The corresponding solar altitude above the examined lunar cone when the image was
acquired corresponds to 9.94°. The diameter computation for the elongated cone yields
2.28 km x 0.74 km. According to measurements of the shadow length (7.7 pixels
corresponding to 0.568 km), the height of the flank of the lunar cone amounts to 95 m ±
10 m. The corresponding flank slope angle amounts to 4.70° for the steepest part of the
cone.

The shape of the examined cone fits the shape of some terrestrial cinder cones (Fig. 3a
and 3b) using the scheme introduced by Breed (1964). Slopes for terrestrial cones can be
up to 33° because of the angle of repose for cinders, but the greater dispersal of clasts on
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the Moon favours lower slopes (McGetchin and Head, 1973).

Preceding studies of lunar cones (Pike and Clow, 1981) report for the cone Isis a height
of 60 m with a corresponding slope of 4.00°, while Osiris has a height of 72 m with a
slope of 3.54°. Isis and Osiris are aligned along a linear rille in southeastern Mare
Serenitatis (cf. AS17-2317 (P) imagery at http://www.hq.nasa.gov/office/pao/History/SP-
362/ch4.3.htm, where the two cones Isis and Osiris are labelled as A and B,
respectively). In the probe imagery shown in Figs. 1 and 2, the examined feature and its
summit crater are strongly elongated and appear different from nearby small craters of
impact origin. Furthermore, in the Lunar Orbiter IV-143-H3 the examined lunar cone is
aligned along a linear rille located to the south, likely produced by a near-surface dike
(Head and Wilson, 1996). At a certain depth below the surface, a dike will cause
extension to produce a graben. If the dike is shallow enough, then degassing of the dike
can occur and cones will be produced, a mechanism proposed by Weitz and Head (1999)
for the origin and formation of lunar cones such as Isis, Osiris and Mons Esam. These
findings support the interpretation that the examined structure, with its elongated crater,
is of volcanic origin.

3. Spectral analysis of the lunar cone

3.1 Methodology using Clementine UVVIS-NIR multispectral imagery

The 5 UVVIS (415, 750, 900, 950, and 1000 nm) and 4 NIR wavelengths (1100, 1250,
1500, 2000 nm) are available at the PDS Map-a-Planet site (http://www.mapaplanet.org/
explorer/moon.html). This work employs the Clementine UVVIS+NIR spectral mapping
technique developed by Evans et al. (2009a; 2009b). The technique is used to produce
spectral maps of the principal spectral mafic absorption features for lunar terrain of
interest. It was employed here in an attempt to discern the mineralogy of the examined
lunar cone. The spectral mapping was obtained using the implementation in Octave as
described by Evans and Lena (2010).

The spectral data (cf. Fig. 4) resulted in the automated production of maps concerning:

a) band center minimum

b) band depth

c) FWHM (full height at half maximum).
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3.2 Clementine multispectral analysis

Examination of spectral maps prepared using the Clementine UVVIS+NIR dataset
reveals that the region of interest (marked in blue square in Fig. 1c) is composed almost
exclusively of clinopyroxene bearing rock with a band center near 0.970 μm and with a
FWHM width of 0.180 μm (cf. Fig. 4). Combined ratio images created from an image set
taken at 0.415, 0.750 and 1.000 μm provides basic information on lunar surface
maturation and limited information about mafic composition (Tompkins et al., 2000). To
create a maturation image, the R0.750/R0.415μm ratio image is assigned to the red channel,
the R0.750/R1.000μm ratio image to the green channel, and the R0.415/R0.750μm ratio image
to the blue channel. In the maturation image, immature surfaces appear greenish-blue
while older mature soils appear red, the yellow color indicates freshly excavated basalt
features (cf. maturation image shown in Fig. 4). The process of surface maturation causes
a reddening of the surface spectra (increase of a positive slope) and a decrease of the
spectral contrast of the absorption bands. No significant differences are detectable in the
maturation image of the examined region, suggesting an overall high soil maturity.
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Figure 4
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The individual Clementine spectral plot, shown in Fig.5, is also consistent with the
presence of high-Ca clinopyroxene with a band centre at 0.970 μm. Furthermore, the wall
of Flamsteed P has a highland signature (Fig. 7a and b) although it is low in reflectance,
suggesting a mature material (red in the maturation image shown in Fig. 4). Moreover,
using representative spectra for highland rocks taken by Tompkins (1998) and Tompkins
and Pieters (1999) the spectrum of the wall shows the presence of a plagioclase feldspar
signature of GNTA 1 type (Fig. 7c and 7d). Plagioclase feldspar is spectrally
characterized by a continuous upward slope from 415 to 900 nm and an absorption band
at about 1300-1500 nm. Low-Ca pyroxene, which may be intermixed with plagioclase
shows an absorption band at 940 nm with a secondary broad absorption band centred at
about 1060 nm (Fig. 7c). Hence, the spectral data indicate the presence of the plagioclase
feldspar containing up mafic minerals composed of a mixture of orthopyroxene and
olivine.

In order to investigate the style of the eruption conditions, the spectral data of the
examined cone were compared with the spectra extracted from the cones Mons Esam,
Isis and Osiris, which are aligned along a rille without any apparent associated
pyroclastic deposit, according to the preceding study by Weitz and Head (1999). The
multispectral images reveal that the material of the Flamsteed cone appears comparable
to those of Isis, Osiris and Mons Esam (Fig.6). Compared to the two well known cones
Isis and Osiris, the examined cone displays a lower R415/750 ratio at 0.750 μm (0.616 vs.
0.660) indicating a lower TiO2 content. Moreover the material of these cones does not
have the typical signature of volcanic glasses, compared as “black bead” and “orange
glasses” (Gaddis et al., 2003).

The lack of associated dark deposits and volcanic glass signature at Mons Esam,
Flamsteed cone, Isis, and Osiris may be due to large gas bubbles in the magma. In this
case only larger clasts were formed during fragmentation of the magma. Otherwise the
clasts will be dispersed to form dark mantle deposits. Hence, in the examined cone little
fine-grain clasts were produced in the eruption.
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Figure 5: Individual Clementine spectral plot for the marked region corresponding
to the examined lunar cone.
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Figure 6: Spectra of the examined lunar cone compared with the cones Isis, Osiris
and Mons Esam.
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4. Calculation of Elemental Abundances using Clementine UVVIS+NIR data

Lunar Prospector (LP) data provides elemental abundance ground truth, but at low spatial
resolution. This resolution, however, may be increased using the method described by
Wöhler et al. (2009) which represents LP data in terms of a transformation of spectral
parameter maps for the absorption trough near 1 μm derived from Clementine
UVVIS+NIR imagery. Creation of these spectral maps is discussed in Evans et al.
(2009). Mathematically, a data matrix can be represented by the transformation of a
second matrix according to equation (1) where matrix x and matrix b are of the same
width:

Ax = b (1)

Using this model, the global LP elemental abundance map for a given element is termed
the ground truth matrix and is matrix b. It is a row matrix of height one and width equal
to the row*column dimension of the LP image. A set of spectral parameter maps includes
the band center, band depth, FWHM and slope, where only the deepest minimum is
regarded, and their quadratic combinations. Each row in matrix x consists of one of these
spectral maps written as a single row matrix of height one and width equal to the
row*column dimension of the map image. In addition to the spectral maps described
above, their pairwise product maps are also added to matrix x. Matrix A is the coefficient
matrix giving the gain and offset values that matrix b must be applied to effect its
transformation into a form approximate to matrix x.

When the equation Ax = b is solved for A using standard linear algebra techniques, one
obtains the gain and offset coefficients necessary to transform matrix x into an
approximation of the ground truth matrix b. Matrix A has height one and width equal to
the number of rows in matrix x. The last element in Matrix A is the offset and all other
elements are gain coefficients. This feature set does not comprise the albedo itself, and
produces a similarly good fit to the global LP data as the Lucey Fe and Ti abundances
(Lucey et al., 2000).

These gain and offset coefficients, once derived, are also applicable to any other set of
Clementine based spectral maps even though they represent a much higher spatial
resolution than the global maps used to determine the coefficients. The uncertainty of the
derived elemental abundance maps is ± 1 wt%. Based on this approach, the abundances
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of the elements Ca, Al, Fe, Mg, Ti, and O were estimated (Fig. 8). The wt % range for
the Figure 8 is as follows: aluminum (0-20 wt %), calcium (2-18 wt %), iron (0-25 wt
%), magnesium (0-16 wt %), oxygen (40-47 wt %), and titanium (0-6 wt %).

The elemental abundance values for the Flamsteed cone are reported in Table 1.
Consequently, the Mg/Al ratio (0.83) is lower than would be expected for a volcanic
glass: most volcanic glasses have Mg/Al ratios in the range of 1.7 to 3.3.

The topographic distribution of rock types can be derived from elemental abundance
maps using the three end-member model described by Berezhnoy et al. (2005). The
petrographic map shown in Fig. 9 indicates the relative fractions of the three end-
members mare basalt (red channel), Mg-rich rock (green channel), and ferroan
anorthosite (FAN, blue channel). The wall of ruined Flamsteed P formation appears
composed of highland-like material (blue) surrounded by mare basalt (red-orange).
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Figure 8. Elemental abundances
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Table 1. Elemental Abundances for the examined cone near Flamsteed

Figure 9. The petrographic map indicates the relative fractions of the three end-
members mare basalt (red channel), Mg-rich rock (green channel), and ferroan
anorthosite (FAN, blue channel).

Ca Al Fe Mg Ti O

9.4% 9.1% 12.9% 7.8% 2.2% 43.2%
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5. Results and discussion

The 5-band Clementine UVVIS data have been used to characterize lunar pyroclastic
deposits and their composition (Gaddis et al., 2003). Large pyroclastic deposits (LPD)
are thought to have been emplaced via more continuous, Hawaiian-style, fire fountain
eruptions (Wilson and Head, 1981), whereas smaller pyroclastic deposits were probably
formed via intermittent, Vulcanian-style explosive eruptions (Head and Wilson, 1979).
More continuous lunar eruptions are likely to produce glass beads and crystalline or
partially crystalline droplets. Clementine UVVIS data allowed to examine the spectral
ratios for some volcanic cones such as the well known cones in the Marius hills region,
Mons Esam, and Isis and Osiris in Mare Serenitatis (Weitz and Head, 1999). The spectral
analysis reveal that the material of the Flamsteed cone appears comparable to those of
Isis, Osiris and Mons Esam (Fig. 6) and the lower R415/750 ratio indicates a lower TiO2

content when compared with Isis and Osiris. The height of the examined cone was
computed as 95 ± 10 m.

The morphometric data for Osiris and Isis, reported in section 2, were adopted from Pike
and Clow (1981). The volume of the cones were, then, estimated according to the
empirical relation Vcone = (0.408) h D2 established by Wood (1979), corresponding to a
form factor of f = 0.52. Hence the volumes correspond to 0.20, 0.16 and 0.071 km3 for
the Flamsteed cone, Osiris and Isis, respectively. According to Wood (1979) the smaller
volumes for the lunar cones imply that their construction rates were low and their magma
chambers were smaller and at shallower depths than is typical for the terrestrial cones.
Furthermore, lunar cones aligned along a linear rille are evidence for the presence of near
surface magma and interpreted to be the result of degassing and minor eruption
subsequent to a shallow dike (Head and Wilson, 1996). The presence of a lunar cone
implies that gas may be released from the erupted magma, causing disruption of the
magma and subsequent dispersal of the clasts (Weitz and Head, 1999).

Moreover, based on mapping the previously extracted spectral features to Lunar
Prospector gamma ray spectrometer data, the abundances of the elements Ca, Al, Fe, Mg,
Ti, and O were computed (Fig. 8). Accordingly the presence of significant amounts of
volcanic glasses in the examined cone appears to be unlikely based on the low Mg/Al
ratio below 1. The lack of associated dark deposits and volcanic glass signature may be
due to large gas bubbles in the magma, producing only larger clasts during the
fragmentation.
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The soil around the lunar cone displays a single absorption at 0.970 μm, indicating the
presence of high-Ca clinopyroxene. In contrast, the spectral data of the Flamsteed P wall
indicate the presence of the plagioclase feldspar containing up mafic minerals composed
of a mixture of orthopyroxene and olivine, characterized by an absorption band at 0.940
μm with a broad absorption band centred at about 1.060 μm.

The corresponding petrographic map shown in Fig. 9 indicates that the wall of the ruined
Flamsteed P formation appears composed of highland-like material (blue) surrounded
by mare basalt. Finally, the wall of the crater Flamsteed reveals a higher content of Mg-
rich rock.
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